
Unit 1: Getting Started 
Unit Objectives 
In this unit, you will begin to navigate the Word interface and learn the available commands and
features. You will then begin to work with documents and change document settings and views. 
Upon successful completion of this lesson, you will understand the following: 

 Command and Features

 Work with Documents

 Document Settings

 Document Views
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Unit 1 Commands and Features Learn Tasks 
What is Microsoft Word?  

Microsoft Word enables you to create which types of files? (Select all that apply) 

a) Documents  

b) Reports  

c) Spreadsheets 

d) Newsletters   

e) Spreadsheets 

   
Microsoft Word Interface  

In the Microsoft Word window image identify the following: 

1) File Tab  

2) Quick Access Toolbar 

3) Ribbon Tabs  

4) Title Bar  

5) Search Field 

6) Minimize/Maximize/Restore Down/Close  

7) Status Bar  

8) View Buttons  

9) Zoom Slider  

10) Zoom Level  

 
Backstage  

Practice identifying features in the Microsoft Word window. 
 
1) Open Backstage.docx 

2) View the document info in the Backstage view 

• File tab > Backstage view > Info 

3) Create a new document 

• New 

4) Open an existing file  

• Open > Recent > Select a file 

5) Save the file  

• Save 

6) Return to the document  

• Back  

7) Save to your course files 
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ScreenTips  

1) Use ScreenTips to: 

a) View the backstage 

b) Change document views 

c) Help identify buttons  

d) Access frequently used commands 

 

2) This image is a screen tip for _____? 

 
a) Modifying the ribbon options 

b) Modifying the QAT  

c) Modifying the paragraph option 

 
Quick Access Toolbar  

In the Microsoft Word window select the Quick Access Toolbar. 

1) Open Quick Access Toolbar.docx 

2) Select the Quick Access Toolbar 

• Quick Access Toolbar 

3) Save to your course files 

  

 
Ribbon  

Alternate between Ribbon settings in the Microsoft Word window. 

1) Open Ribbon.docx 

2) Select the Ribbon 

• Ribbon  

3) Auto-hide the Ribbon 

• Ribbon Display Options drop-down arrow > Auto-hide Ribbon  

4) Set the Ribbon to only show tabs 

• Ribbon Display Options drop-down arrow > Show Tabs  
5) Set the Ribbon to show tabs and commands 

• Ribbon Display Options drop-down arrow > Show Tabs and Commands  
6) Save to your course files 
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1) Open Ribbon.docx 

2) Select the Ribbon 

• Ribbon  

3) Set the Ribbon to Show Tabs 

• Ribbon Display Options drop-down arrow > Show tabs only 

4) Set the Ribbon to only show only when the cursor is moved over it 

• Ribbon Display Options drop-down arrow > Adjust automatically 
 

Ribbon Tabs 

Find elements related to the Ribbon tabs in the Microsoft Word window. 

1) Open Ribbon Tabs.docx 

2) Display the Insert tab 

• Insert tab  

3) Select the Illustrations group 

• Illustrations group 

4) Display the Design tab 

• Design tab 

5) Select the Style gallery 

• Home tab > Styles group > Style gallery 

6) Display the Home tab 

• Home tab 

7) Display the Font Dialog Box Launcher 

• Home tab > Font group > Font dialog box launcher  

8) Select the contextual tab   

• Header and Footer context tab 

9) Save to your course files 

 

 

Understand Ribbon Tabs  

1) Match the words to their correct descriptions. 

a) Home 

b) Insert 

c) Draw 

d) Design 

e) Layout 
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The __________ tab provides several frequently used editing features, such as copy and paste, 
text formatting with bold, various fonts, alignment, a style, etc. 

The __________ tab allows the user to add extra elements to the document, such as tables, 
icons, shapes, pages, symbols, etc. 

The __________ tab enables the user to use a pen tool. 

The __________ tab provides various formatting options for your document such as themes, 
effects, color schemes, paragraph spacing, etc. 

The __________ tab allows the user to modify the document, including the page orientation, 
margins, page breaks, spacing, etc. 

 

 

2) Match the words to their correct descriptions. 

a) References 

b) Mailings 

c) Help 

d) Review 

e) View 

 

The __________ tab enables the user to enter document sources and citations, build a table of 
contents, add footnotes and endnotes, create an index, etc. 

The __________ tab, which is the least used, allows users to merge emails, write, insert, and 
merge different fields, etc. 

The __________ tab enables users to check grammar, proofread, check accessibility, track 
changes, add or remove comments, etc. 

The __________ tab allows users to shift between different views of the document, change page 
movement, switch windows and has the feature of the Immersive Reader. 

The __________  tab provides you with necessary features such as contacting Microsoft Support, 
providing feedback to Microsoft, viewing training videos and learning about new tools. 

 

3) This ribbon is hidden by default and includes many tools that can help increase productivity 
when working with documents, such as macros, installing add-ins, using content controls to 
build online forms, protect against people making changes, or manage templates. 

a) Review tab 

b) View tab 

c) Mailing tab 

d) Developer tab  
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Unit 1 Commands and Features  
Practice Exercise 
 

Identify the correct Ribbon tab for each function listed. 

1) Open a blank document 

2) Locate the Ribbon tab that provides various formatting options for your document such as 
themes, effects, color schemes, and paragraph spacing 

• Design tab 

3) Locate the Ribbon tab that enables users to check grammar, proofread, check accessibility, 
track changes, and add or remove comments 

• Review tab 

4) Locate the Ribbon tab that provides several frequently used editing features such as 
copy/paste, text formatting with bold, various fonts, alignment, and styles 

• Home tab 

5) Save to your course files 

• File tab > Save 
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Unit 1 Commands and Features  
Practice Questions 
 
1) Which type of document can you create using Microsoft Word? (Choose all that apply) 

a) Agendas  
b) Budgets 
c) Catalog  
d) Invoice  
e) Slide show 

 
2) Fill in the blanks with the correct words.   

Choose commands that manage the document with the __________    , whereas commonly used 
commands can be found on the __________    .  
To activate the Zoom dialog box to enter a view percentage, select the __________    option. To 
see the total number of pages in the document, use the __________    option. 
 
• File tab 
• Quick Access Toolbar 
• Zoom Level 
• Status Bar 

 
3) Which view is available for all Office programs, giving you a central location to manage files? 

a) Backstage  
b) Outline 
c) Normal  
d) Draft 
e) Save As 

 
4) ScreenTips always appear when you point at anything on the screen and always show a 

keyboard shortcut you can use. 

• True 
• False  

 
5) Which buttons are seen on the Quick Access Toolbar by default? (Choose all that apply) 

a) Save  
b) Redo  
c) New 
d) Open 

 
6) The Quick Access Toolbar can only be located at the top left of the application screen. 

• True 
• False  
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7) Match the correct term to the description. 

a) Active Ribbon tab 
b) Group 
c) Dialog box launcher 

 
_____Always displays with different background color or has an outline. 
_____A set of related commands that perform similar tasks, such as cut, copy and paste. 
_____Launches a dialog box or pane with more options for the group of commands. 
 

8) Which of the following Ribbon tabs allows you to draw and create tables for small or large 
amounts of data? 

a) Draw 
b) Design 
c) Insert  
d) Layout 

 
9) A Ribbon tab can be hidden by going into the Word options and in the Customize Ribbon 

option, turn off the checkbox for the Ribbon tab. 

• True  
• False 
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Unit 1 Work with Documents Learn Tasks 
 

New Documents 

Create a new blank document. 

1) Open a blank document 

• File tab > New > Blank document 

2) Save to your course files 

 

 
1) Open Microsoft Word in 365 (Web) 

• App launcher (grid icon) > Word icon  

2) Open a new document 

• Create blank document  

1) Open a new document in Microsoft Word Online 

• Create or Upload > Word document  

 
Document Templates 

Create a new Word document based on the Pet Volunteer Opportunity flyer template. 

1) Open the New window 

• File tab > New  

2) Create a flyer based on the Pet Volunteer Opportunity template 

• Flyers > Pet Volunteer Opportunity > ENTER > Create 

3) Save to your course files 

 
 
1) Select the template on the Home page 

• Home page > Create with templates > Search box : Pet Volunteer Opportunity > ENTER > 
Edit 

Open Documents 

Place the steps to opening a file in the correct order. 

1) Select File  
2) Select Browse 
3) Select Open  

 
Save Documents 

Fill in the blank with the correct word. 

Select File > __________ to change the name or location of a document. 
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• Open 
• Save 
• Save as 
• Create 

 

Save PDFs 

Save a document as a PDF. 

1) Open Save PDFs.docx 

2) Save the document as a PDF 

• File tab > Save As > Browse > File type drop-down arrow > PDF (*.pdf)  

3) Save to your course files 

 
1) Open Save PDFs.docx 

2) Save the document as a PDF 

• File tab > Export > Download as PDF > Download  

 

Convert PDFs to Word Documents 

1) You can open a PDF file in Microsoft Word by selecting File and then Open. 

• True  
• False 

 

2) Microsoft Word allows you to open PDF files but you will not be able to edit the file. 

• True 
• False  

 

Word File Types 

You can save a Microsoft Word file in the following formats. (Choose all that apply) 

a) .txt  
b) .rtf  
c) .docx  
d) .mov 
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Identify Extensions 

Match the file formats to their correct descriptions. 

a) .docm 

b) .dotx 

c) .dotm 

 

_____Macro-enabled document 

_____Template 

_____Macro-Enabled Template 
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Unit 1 Work with Documents  
Practice Exercise 
Practice using templates. 

1) Open a new document based on the Festive party flyer 

• File tab > New > Flyers > ENTER 

• Festive party flyer > Create 
2) Save your document to the Starter Files folder as a PDF 

• File tab > Save As > Browse  

• Save as file type drop-down arrow > PDF (*.pdf) > Save 

3) Close the document without exiting Word 

• File tab > Close 

4) Open the Festive party flyer.PDF in Word 

• File tab > Open > On this PC > Starter Files folder 

• Festive party flyer.PDF > Open 

5) Save to your course files 

• File tab > Save 

 
1) Open a new document based on the Festive party flyer 

• App launcher (grid icon) > Word icon 

• Search field: Festive Party flyer > ENTER > Edit 

2) Save your document as a PDF 

• File tab > Export > Download as PDF > Download 

3) Open the Festive party flyer.PDF in Word 

• File tab > Open > Open files from this device 

• PDF file > Open > Open 
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Unit 1 Work with Documents  
Practice Questions 

 
1) Fill in the blanks with the correct words.  

All documents are based on a __________ which determines __________ for the document. 
 
• Template 
• Files 
• Basic Formatting 
 

2) You can only open documents from a cloud location.  

• True 
• False  

 

3) When you save a file for the first time, the Save as view displays in Backstage. 

• True  
• False 

 

4) Which file type extension is used when templates are saved in Office 2019? 

a) .dotx  
b) .docx 
c) .dot 
d) .doct 

 
5) What does PDF refer to? 

a) Portable Document Format  
b) Portable Document File 
c) Personal Default File 
d) Portable Default Format 

 

6) You can convert a PDF file into a Word format but you may also need to edit the file, especially if 
there are a number of pictures in the PDF file. 

• True  
• False 

 
7) Which file type is associated with Word 2007 and later? 

a) .docx  
b) .doc 
c) .dotx 
d) .dot 
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8) By default, Microsoft displays a list of Word documents in the Open dialog box. Review the 
following image and select the number that represents the option you would use to view other 
file types. 

 
a) 1  Search field 
b) 2  View button 
c) 3  All Files button  
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Unit 1 Document Settings Learn Tasks 
 

Review Document Statistics 

Use the Review tab to display document statistics. 

1) Open Review Document Statistics.docx 

2) Display the Word Count dialog box 

• Review tab > Proofing group > Word Count  

3) Save to your course files 

 

Document Properties 

View advanced document properties and all properties. 

1) Open Document Properties.docx 

2) Open the Info page to view the Properties 

• File tab > Info > Properties > Advanced Properties > OK 

3) View the Advanced Properties 

• Properties drop-down arrow > Advanced Properties > OK  

4) Display All Properties of the document 

• Show All Properties 

5) Save to your course files 

 

Inspect Document 

Remove all document properties and personal information. 

1) Open Inspect Document.docx 

2) Navigate to the Info page and inspect the document 

• File tab > Info > Check for Issues > Inspect Document 

• Yes > Inspect 

3) Remove all Document Properties and Personal Information 

• Select Remove All next to Document Properties and Personal Information > Close 

4) Save to your course files 

 

Check Accessibility 

Practice checking for Accessibility issues. 

1) Open Check Accessibility.docx 
2) Check for accessibility issues in the document 

• File tab > Info > Check for Issues > Check Accessibility 
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3) Review the Media and Illustrations list for missing Alt text 

• First image > Add a description > Save 

• Next arrow > Second image > Mark as decorative 

4) Save to your course files 

 

Check Compatibility 

Check document compatibility for older Word versions. 

1) Open Check Compatibility.docx 

2) Check the document for compatibility issues with Office 2010 

• File tab > Info > Check for Issues > Check Compatibility 

• Select Versions to show > Word 2010 > OK 

3) Save to your course files 

 

Print Preview 

Fill in the blanks with the correct words.  

Open the print preview of a document select the __________ tab then __________ . 

• File 

• Layout 

• View 

• Print 

Set Print Parameters 

Review how to change print settings for a document. 

1) Open Set Print Parameters.docx 

2) Display the Print Preview page 

• File tab > Print 

3) Select the following settings: 

• Printer: OneNote printer 

• Collation: Print One Sided 

• Orientation: Portrait  

• Paper size:  A4  

• Margins: Normal  

• Pages Per Sheet: 1 Page Per Sheet > Close 
4) Save to your course files 

 

1) Open Set Print Parameters.docx  
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2) Open the browser Print dialog box 

• File tab > Print 

3) Select the following settings: 

• Destination: Printer 

• Pages: All 

• Pages Per Sheet: 1 Page Per Sheet 

• Save  

 

Share Documents 

Fill in the blanks with the correct words. 

You can share documents by __________ the document or giving someone the__________  

• Emailing 
• Sharing Link 
• Hyperlink 
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Unit 1 Document Settings  
Practice Exercise 
Practice reviewing document statistics, updating properties, sharing, and fixing accessibility 
issues.  

1) Open U1 L3 Practice Exercise.docx 

2) Review the document statistics 

• Review tab > Proofing group > Word Count > Close 

3) Change the following document properties 

• File tab > Info > Title: Greece Project 

• File tab > Info > Tags: social science, Greece, assignment 

4) Share your document that allows editing 

• Share > Share  

• Email address > Send 

5) Check and fix accessibility issues for the missing object description 

• File tab > Info > Check for Issues > Check Accessibility 

• Media and Illustrations > Missing alt text > Picture 1 > Add a description > Save 

• Next arrow > Picture 2 > Mark as decorative 

6) Check compatibility issues 

• File tab > Info group > Check for Issues > Check Compatibility > OK 

7) Check the document for headers, footers, and watermarks, then remove them 

• File tab > Info group > Check for Issues > Inspect Document > Inspect > Remove All 
Headers, Footers, and Watermarks > Close 

8) Close the Backstage view 

• Back 

9) Save to your course files 

• File tab > Save 

 
 
1) Open U1 L3 Practice Exercise.docx 

2) Review the document statistics 

• Review tab > Proofing group > Word Count > Close 

3) Share your document that allows editing 

• File tab > Share > Share with people  

• Email address > Send 

4) Check and fix accessibility issues for the missing object description 

• Review tab > Accessibility group > Check Accessibility 

• Errors > Missing alt text > Picture 1 > Add a description > Save 

• Errors > Missing alt text > Picture 2 > Mark as decorative 
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Unit 1 Document Settings Practice Questions 
 
1) To display statistics for the document, which option would you choose? 

a) Review tab > Proofing group > Word Count  
b) Review tab > Proofing group > Thesaurus 
c) Review tab > Proofing group > Spelling and Grammar 
d) References tab > Research group > Smart Lookup 

 
2) Which option in the Info category of Backstage opens the Document Inspector tool? 

a) Check for Issues  
b) Check Accessibility 
c) Protect Document 
d) Manage Document 

 
3) Which of the following items can have Alt Text applied? (Select all that apply) 

a) Images  
b) Charts  
c) Text 
d) Citations 

 
4) Which tab will you find the Compatibility Checker tool? 

a) File  
b) Home 
c) Review 
d) View 
 

5) You must have a color printer that can print on double-sides of the paper before you can preview 
the document in Word. 

• True 
• False  

 
6) You need to print 3 copies of the monthly newsletter for a meeting. The copies need to be 

collated. What does this refer to? 

a) Three copies of page 1 will print first, then the three copies of page 2, and finally three copies 
of page 3.  

b) All three pages of the newsletter will be printed and then the remaining two copies of the 
newsletter will be printed. 

 
7) What are the most common methods to share a document? (Select all that apply) 

a) As an email attachment.  
b) Send an invitation to share a document with others.  
c) Save the file to a flash drive that others can copy to their computing device. 
d) Print a copy of the file and distribute to others. 
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8) If you want to send your file as an attachment to three people, why might you choose to send the 
attachment as a link instead? Select all that apply 

a) The three people only have to click the link to download their own copy of the file for 
changes.  

b) Sending a link keeps the email small in size.  
c) This method is faster if the three people are in the same location. 
d) The link shows the three people where the file can be found but they cannot save their 

changes in that location. 
 
9) What is the one thing you must have before you can share or invite people to access the shared 

online file? 

a)  You must have a valid account to a OneDrive or SharePoint location that the others also 
access.  

b) You must all be connected to the same company network. 
c) You must the access for everyone to be able to edit the file. 
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Unit 1 Document Views Learn Tasks 
Change the View 

Select each of the following from the status bar. 

• Read Mode 

• Web Layout 

• Print Layout 

 
 

Manage Views 

Match the term to the definition. 

a) Read Mode 

b) Print Layout 

c) Web Layout 

d) Outline 

e) Draft 

 

_____Useful for reading a document 

_____Use to adjust the overall layout of information on the document page, or to show how the 
printed document will look 

_____Useful for creating pages that will be viewed with web browser  

_____Create a document to promote or demote headings in a hierarchical layout. 

_____Appropriate for most typing and editing of text. 

 
Manage Outline View 

Practice switching to Outline view, promoting/demoting headings, and closing the view. 

1) Open Manage Outline View.docx  

2) Switch to the Outline view 

• View tab > Views group > Outline 

3) Collapse the Corporate Profile level 

• Use the pointer to double-click the + to the left of the Corporate Profile heading 

4) On page 1, under the Tolano Environmental Consulting heading, demote the New York 
heading to Level 4 
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• Navigation pane > Pages > Page 1 > New York  

• Outlining tab > Outline tools > Outline Level drop-down arrow > Level 4 

5) On page 4, under the Tolano Adventures heading, promote the New York heading to Level 4 

• Navigation pane > Page 4 > New York  

• Outlining tab > Outline tools > Outline Level drop-down arrow > Level 4 

6) Close the Outline view 

• Outlining tab > Close group > Close Outline View 

7) Save to your course files 

 

 

Zoom 

Practice adjusting document zoom using the slider, button, and ribbon commands. 

1) Open Zoom.docx 

2) Select the Zoom Slider 

• Status bar > Zoom slider 

3) Select the Zoom Button 

• Status bar > Zoom 

4) Display the Zoom group on the ribbon 

• View tab > Zoom group 

5) Zoom to 100% 

• View tab > Zoom group > 100% 

6) Save to your course files 

 

Split the Window 

Fill in the blanks with the correct words.  

To split the window, on the __________ tab > __________ group> __________ . 

• View 

• Window 

• Split 
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Show/Hide ¶ 

Match the term to the description.  

a) Space character 

b) Tab character 

c) Hard page break 

d) Soft page break 

e) Paragraph mark 

 

_____Inserts every time you use the keyboard button Enter 

_____Inserts every time you use the keyboard button Tab 

_____Appears when you enter the maximum number of lines per page 

 

Ruler 

Display the horizontal and vertical rulers. 

1) Open Ruler.docx 

2) Use the View tab to display the Ruler 

• View tab > Show group > Ruler  

3) Save to your course files 
 

Gridlines 

Fill in the blanks with the correct words.   

Gridlines are helpful when you want to align items on the page, such as images, shapes, etc. To 
display gridlines on your pages, on the __________ tab > __________ group > __________ . 

• Show   

• View   

• Gridlines 
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Unit 1 Document Views Practice Exercise 
 

Practice using rulers, gridlines, nonprinted characters, navigation tools, and window options. 

1) Open U1 L4 Practice Exercise.docx  

2) View the ruler and gridlines 

• View tab > Show group > Ruler > Gridlines  

3) Show the nonprinted characters 

• Home tab > Paragraph group > Show/Hide ¶ 

4) Locate the page break and delete it 

• Scroll down to the Manual Page Break > Place the cursor in front of the page break > 
DELETE 

5) Use the status bar to change the document view to Read Mode 

• Status bar > Read Mode 

6) Use the status bar to return to Print Layout View 

• Status bar > Print Layout View 

7) Turn off the gridlines 

• View tab > Show group > Gridlines 

8) Split the window 

• View tab > Window group > Split 

9) Save to your course files 

• File tab > Save 

 

1) Open U1 L4 Practice Exercise.docx  

2) View the ruler 

• View tab > Show group > Ruler  

3) Show the nonprinted characters 

• Home tab > Paragraph group > Show/Hide ¶  

4) Locate the page break and delete it 

• Scroll down to the Manual Page Break > Place the cursor in front of the page break > 
DELETE 

5) Change the document view to Reading View 

• View tab > Reading View  

6) Return to Separate Pages view 

• Edit document drop-down arrow > Edit  
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Unit 1 Document Views Practice Questions 

1) Of the three view buttons on the Status bar, which one displays the horizontal and vertical 
rulers? 

a)  Print Layout  
b) Read Mode 
c) Web Layout 

 
2) Which of the five views in the View tab does not display the Ribbon at all when active? 

a) Read Mode  
b) Print Layout 
c) Web Layout 
d) Outline 
e) Draft 

 
3) Match the correct term to the description. 

a) Promote the text 
b) Demote the text 
 
____Moves the text up a level 
____Moves the text down a level 
 

4) When you tell Word to show the text at Level 5, what will Word display? 

a) The titles in the document with Heading 1 to Heading 5 styles.  
b) All text from page 1 to page 5. 
c) The first five headings per page. 
d) All text until Word encounters a Heading 5 style. 

 
5) When you select the incremental button at the left side of the Zoom slider, what happens? 

a) The zoom percentage will decrease the view by 10% at a time.  
b) The zoom percentage will increase the view by 10% at a time. 
c) The Zoom dialog box will appear with further options. 
d) The screen moves down by three lines at a time. 
e) The screen moves up by three lines at a time. 

 
6) If I wanted to view the top of page 3 and the middle of page 6 at the same time, which feature 

should I activate? 

a) Split Windows  
b) Switch Windows 
c) View Side by Side 
d) New Window 

 
7) Which Ribbon tab will you find the Show/Hide ¶ command? 

a) Home  
b) Layout 
c) View 
d) Insert 
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8) Which view displays the horizontal and vertical rule once the ruler is active? 

a) Print Layout  
b) Read Mode 
c) Web Layout 
d) Outline 

 
9) If you have a number of rectangular boxes on the page that you want to align at a particular 

measurement, which feature can help you achieve this quickly? 

a)  Gridlines  
b) Rulers 
c) Show/Hide ¶ 
d) Tab stops 

 
10) Match the correct term to the description. 

a) Headings tab 
b) Pages tab 
 
_____Displays the titles by Heading styles 
_____Displays a thumbnail of each page's content 
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Unit 1 Create Project 
The Create project is designed to allow the application and demonstration of new knowledge, skills, 
and personal creativity to produce a project-based result while integrating rubric requirements 
using a checklist. 

Tip: While working on your project, remember to save your progress regularly. This will allow you 
to come back to it later. To continue working, open the document, then launch the platform using 
the Add-in whenever you're ready. 

Begin your project by: 

1. Create a new document using a brochure or flyer template 
2. Save the document on your computer 
3. If needed, open the document 
4. Launch XED 

Choose from one of the projects below:  

• Create a Personal Biography: Use a Word template to write a short personal biography 
about yourself. Include your name, background, interests, and a fun fact about you. 

• Design a Simple Event Flyer: Create a flyer for a school event, club meeting, or family 
gathering using a Word template. Add a title, date, time, location, and a short description of 
the event. 

• Write a Short Letter: Create a short letter to a friend, family member, or fictional character. 
Use proper letter formatting, paragraph spacing, and an appropriate closing. 

• Your Own Project Proposal: Propose a project idea of your choice to your instructor for 
approval. The goal is to develop a creative and feasible project idea that aligns with the 
course objectives and your interests. 

Complete a document using the following as a guide/checklist. 

� Use the gridlines and rulers to align images and text 
� Use the Show/Hide to remove unneeded breaks 
� Change the view of the document to ensure you have the desired design 
� Update the document properties to include a document title and your name as the author 
� Inspect the document to ensure there is no hidden text or comments 
� Check the document’s accessibility and resolve any issues 
� Save the document as a PDF 
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Unit 1 Objective Assessment 
 
1) You have been tasked with creating an article to be published in an online monthly 

newsletter. The article needs to have no more than 500 words and at least two photos. They 
have also asked if you can provide a ready-to-publish professional document. Which software 
program would you use to create this article? 

a) Microsoft Word  
b) Microsoft Publisher 
c) Microsoft PowerPoint 
d) Adobe InDesign 

 
2) A friend has asked you to help them identify some basic terms on the Word Interface so they 

can understand the screen. Match the correct term to the description.  

a) Quick Access Toolbar 
b) Title Bar 
c) Tell Me 
d) Status Bar 
 
_____Frequently used buttons on a toolbar   
_____March Sales Figures report name   
_____On screen help field                      
_____Spelling error icon location        

 
3) A simple purpose for Backstage is that options in this view are related to things you can do 

with the entire file itself. 

• True  
• False 

 
4) To help a friend who is struggling with learning the new features of Word, which option would 

you direct them to read and reinforce skills on the screen? 

a) ScreenTips  
b) Tell Me 
c) File tab 
d) Status Bar 

 
5) Word provides a number of tools you can use to complete tasks. Which of the following tools 

would you use for frequently used actions? 

a) Quick Access Toolbar  
b) Ribbon Tabs 
c) File Tab 
d) Tell Me 
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6) To demonstrate your understanding of how a Ribbon tab can be set up, review the following 
image and then match the number to the image with its description. 

  
a)  Active Ribbon tab 
b)  Active command 
c)  Dialog box launcher button 
d)  More button for a gallery 
e)  Group of similar commands 

 
_____Active Ribbon tab 
_____Active command 
_____Dialog box launcher button 
_____More button for a gallery 
_____Group of similar commands 

 
7) One way to learn where commands can be found is to associate them with specific types of 

tasks. Review the following descriptions and then match the words to the Ribbon tab name 
that best suits the description. 

a) Home 
b) Insert 
c) Review 
d) References 
e) Layout 
f) Design  
 
_____Commonly used commands such as copy and paste. 
_____Insert anything other than text. 
_____Check and proof the document before distributing 
_____Insert research sources or links for a report. 
_____Set up options for how the page will appear.      
_____Apply elements to change the page’s overall appearance. 

 
8) When you launch Word, the Backstage view appears. What can you do next? (Select all that 

apply) 

a) Create a new blank file  
b) Open an existing file  
c) Save an existing file 
d) Save a new blank file 
e) Print the new blank file 

 
9) Many people use the PDF format to share files. Identify which of the following options are 

benefits of using the PDF format. (Select all that apply) 

a) Maintains the design layout and format for distribution.  
b) Restricts others from editing the file.  
c) Makes the file smaller to use as a link for downloading.  
d) PDF files can be read in any program for easy reviewing. 
e) PDF files are always saved as read-only. 
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10) You receive a PDF file of the inventory list at the warehouse. The inventory items appear to 
have been set up as columns. Why might you want to convert this file into a Word document 
versus an Excel spreadsheet file? 

a) The PDF can be opened and converted directly within Word.  
b) You need to convert the PDF file to a text file before you can open it in Excel. 
c) Word will automatically convert the file into a table format. 
d) Excel will convert the file into a database format. 

 
11) Fill in the blanks with the correct words. 

Word automatically assigns a __________ extension to the end of the file name. If you need the 
file to open in a previous version, you should save the file using __________ extension. 
The __________ extension can also be opened by other word processing programs without 
needing any formatting edits. The easiest file format to open in an application with the 
__________ extension but it does not include any formatting. 
 
• .docx 
• .doc 
• .doc 
• .txt 
 

12) It is important to check for any accessibility issues before you share documents with others on 
a global basis. This is crucial when posting online documents with audio or visual elements. 
How does Alt text help with addressing the accessibility issues? (Select all that apply) 

a) Alt Text provides a description for an object that cannot be identified with a text reader.  
b) Alt Text checks to ensure the text is valid for any translation of the document text. 
c) Alt Text checks that a list of figures is available for all images or objects in the document. 
d) Alt Text is saved with an image file so this file can be used in any online document.  

 
13) Knowing that objects in documents are compatible with higher versions of Word, why is it 

important you run the Compatibility Checker before sharing a Word 2019 document with a 
friend who has Word 2007 installed? 

a)  Some objects such as SmartArt diagrams are not compatible with previous versions of 
Word.  

b) Running the Compatibility Checker tells you how much the file will be reduced in size to 
match Word 2007 requirements. 

c) Computing devices with Word 2007 generally do have enough RAM memory installed to 
show a document with lots of pictures. 

d) This is not a concern as newer versions of Windows address compatibility issues. 
 

14) Fill in the blanks with the correct words.  

When you save documents to a __________ location, you will see different __________ of the file 
appear in a list. 
This can be helpful if you __________ with others on the same file and you want to __________ 
the changes made to the file yesterday. 
 
• collaborate 
• versions 
• cloud 
• review 
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15) You can preview your document at any time to view how it will print. In this view, you can 
adjust the size of the page(s) in the document. Review the following image and then select 
the number for the feature that enables you to zoom into a single page. 

 
a) 1 
b) 2 
c) 3 
d) 4   

 
16) Just as you are ready to print the final version of the promotional sheet, a friend tells you some 

last minute changes are needed. This includes customizing the margins, changing the 
orientation, and possibly adding columns to the bottom portion of the document. Which 
option would you use to make these changes? 

a)  Print parameters in the Preview view of Backstage 
b) Select Page Setup in the print parameters and made changes using the options in the 

Layout tab  
 

17) You have been working on an agenda for next month’s staff meeting. Now that you are done, 
you need to share it with your friends. Which is the best method to share the file? (select all 
that apply) 

a) Send the file via email to everyone.  
b) Save it to your OneDrive Personal location. 
c) Send an invite to your friends with a link to the online file  
d) Save the file to a central Teams location. 

 
18) You are working on a project at home and currently do not have access to your files on the 

school network (Internet is active but the school network is down for maintenance). Which is 
the best option to send the work you’ve done on the project to your team members? 

a) Send the file via email as an attachment.  
b) Save the file to USB that can be shared between your team members. 
c) Go to the public library where you can send the file to the school network. 
d) Ask the team to come to your home to get a printout. 
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19) There are a number of ways you can change the view of the document contents. Review the 
following image and select the number that identifies the View buttons. 

 
 

a) 1 
b) 2 
c) 3  
d) 4 

 
20) Knowing that you can change the view as required, review the following terms and 

descriptions and match the terms to correctly identify when you would use this view. 

a) Read Mode 
b) Print Layout 
c) Web Layout 
d) Outline 
e) Draft 

 
_____Read the document as if it were a book. 
_____Show all items in the document as if this were a printout.  
_____Show the page as if viewing it on a web browser.  
_____Create a table of contents to show the flow of the topics in the document.  
_____Focus on entering the text content in the document.  

 
21) Depending on the document, you may need to zoom in or out of areas in a document to see 

more or less detail. Why would using the Zoom Level button to change the zoom be faster to 
return to 100%? 

a) The Zoom dialog box appears where you can then 100% and then OK.  
b) This button automatically returns to 100% when selected. 
c) You need only to double-click this button to return to 100%. 
d) It automatically returns you to the last percentage used for the zoom. 

 
22) Showing the formatting characters on the screen can be beneficial when editing the text. 

Review the following points and select those which could be included as a benefit. (select all 
that apply) 

a) You can quickly delete extra tab characters that affect the alignment of text.  
b) You can quickly identify if there are extra blank lines you don’t need in the file.  
c) You can identify where the alignment of text was changed. 
d) You can see if you need to add more spacing or images in the document. 
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23) You want to create a diagram that shows the process for a sales strategy and want to display 
gridlines to help align the text boxes. Which Ribbon tab will you find the Gridlines feature? 

a) View  
b) Insert 
c) Draw 
d) Design 

 

24) There are requirements you need to consider before sharing your files to an online storage 
location such as OneDrive. Review the following items and select the appropriate response for 
each of the items. 

a) Have a Microsoft account.  
b) Access to a valid OneDrive business or school location.  
c) Invite others to view or edit the file.  
d) Must use Edge as the web browser. 
e) File must be 100Kb in size or smaller. 
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Word Unit 1 Key Terms 
Term Definition 

.docx The file type associated with Microsoft Word 2007 and later and is 
automatically assigned to the end of a file name. 

Accessibility 
Checker 

A feature you can use to ensure that a document can be accessed globally on 
various devices for users with accessibility issues, such as visual or audio 
impairment. 

Backstage The view that appears when you select the File tab. It provides commands 
that deal with the entire file. 

Compatibility 
Checker 

A feature you can use to ensure that a document can be opened in older 
versions of Word or in a different format that may be required for another 
program. 

Contextual Tabs A hidden tab or menu that appears when objects, such as text, images, or 
other elements are selected.  

Dialog Box 
Launcher 

The button at the lower right of a Ribbon group that displays a dialog box or 
pane with more options for specific features. 

Document 
Inspector 

A feature you can use to check a document for items you may not want others 
to view if you share the document, such as personal information. 

File Formats The standard way that information is encoded in an electronic file. The file 
format is indicated by the file name extension. 

Go To Feature  A quick method of jumping to a specific page.   

Gridlines A feature to help align items on a page such as images and shapes.   

Navigation Pane When active, a pane appears on the screen to help you search for text and 
displays the results by headings, pages, or a list of the results in the document. 

Page Orientation The direction of the paper for text flow. Portrait uses the length of the paper 
vertically. Landscape uses the length of the paper horizontally. 

PDF A file format used to maintain the design layout and format of a file for 
distribution to others, restrict the editing of file contents, or to make a file 
smaller so it can be set up as a link on a website for downloading. 

Quick Access 
Toolbar 

Contains popular commands such as Save, Undo, and Redo. This toolbar can 
be customized for those commands you use frequently. 

Ribbon A collection of tabs located directly below the title bar, which provides quick 
access to commands required to complete a task. 

Ribbon Groups The groupings on each ribbon tab containing commands for specific tasks. 

Ribbon Tabs A collection of command buttons organized into logical groups that relate to 
a type of activity. 

Save The command used to store a document. 

Save As The command used to save an existing document with a new name or to a 
different location. 

ScreenTip A feature in which a small pop-up window appears when a mouse pointer 
hovers over an icon or button. The pop-up window will provide details that 
explain the icon’s or button’s function. 
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Template Pre-designed document that can be used to create a specific type of 
document. Setting up a template enables documents to have a consistent 
look. 

View Options Different ways of being able to view the document, usually to assist in working 
with the text, page layout, web layout, an outline, or reading. 

Zoom A feature that enables you to enlarge or decrease your view of the document. 
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